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Introduction

The Silhouette Mint™ custom stamp maker is a 
powerful stamp-creation tool used in conjunction 
with its easy-to-use software, Mint Studio™� In 
this eBook, you’ll learn to design and mint a variety 
of stamps, so you can take those ideas and start 
creating your own custom stamps for personal 
projects, business, or gifts�

The Mint machine uses a thermal printing process 
to create detailed images on Mint stamp sheets� 
When you apply ink, it soaks into the printed 
portion of the stamp sheet, and then your stamp 
can be used up to 50 times or more before you 
need to reapply any ink� In addition, you can use 
multiple ink colors on a single stamp�

Supplies

You only need a few things to make and use your own stamps:

 f Stamp kits: Stamp kits include a wooden 
stamp base, a stamp sheet that’s ready to 
mint, a stamp mount with a lid, and labels 
to mark your completed stamp� These come 
in seven sizes, and each kit makes one 
complete stamp�

 f Silhouette Mint™ stamp maker: This is a 
standalone machine in the Silhouette line� It 
is used with the Mint Studio™ software�
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 f Stamp sheet sets: Stamp sheet sets are 
the refills for the stamps� Sheet sets include 
two stamp sheets, two stamp mounts, and 
two labels� The wooden stamp base is not 
included, but all stamp sheets of the same 
size can share the same wooden base for 
that size�

 f Mint ink: The ink used on the Mint stamps 
is specially formulated to absorb into the 
printed stamp design and stamp in vibrant 
colors� You can stamp 50 times or more 
before needing to reink the stamp�

 f Paper: Use scratch paper to blot excess ink 
each time you ink or reink a stamp�

 f Mint Studio™ software: This is the 
software that controls the Mint machine� It 
is similar to Silhouette Studio® in that you 
use it to create your design and then send it 
to your machine�

Now that you know what the Mint is and the 
supplies you need to use it, let’s talk about the 
Mint Studio™ software�

Work in Mint Studio™

 f Mint Studio™ is the software you use to 
design your custom stamps and then send 
the designs to your Mint machine� You can 
download Mint Studio™ for free from the 
software section of SilhouetteAmerica�com�

 f Mint Studio™ can use imported images, 
photos, designs from the Silhouette Design 
Store, drawing tools and frames, fonts on 
your computer, and any combination of 
these to create the perfect stamp� It’s easy 
to adjust your designs and apply filters to 
customize the look of your stamp images� 

 f We’ll go over how to use different features 
of Mint Studio™ as we create several 
stamps in this eBook�

https://www.silhouetteamerica.com/software
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Create a Simple Stamp 

There are four basic steps for creating every Mint stamp:

1� Design it

2� Mint it

3� Ink it

4� Stamp it

Design it.
For our first stamp, we’ll use the “Made with Love” design (ID #238969) from the Silhouette Design Store� 

If you need to open a new document, you 
can do so by clicking New Drawing in the 

upper left�

Your Library is on the left sidebar, where 
you can find all the designs that come 

preloaded with your Mint machine, along with any 
designs you purchase from the Silhouette 
Design Store�
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You can get to the Design Store with the 
icon just below the Library and purchase 

any designs you like�

If you need to get back to the Design view, 
the top icon above the Library and Store 

icons will take you there�

Once you’ve purchased a design from the Design 
Store, enter the Library� In this example, we’ll 
search for “Made with Love” in the search bar� 
Double-click to open it in the design area�

Now you need to choose a stamp size� 
Open the Stamp Settings window, with the 

icon along the top that looks like a stamp sheet� 
For this stamp, let’s choose 30 x 30 mm, which is 
one of the sheet sizes that comes with 
the machine�
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A quick way to resize the design to fit the 
stamp is to choose Fit to Stamp at the 

bottom of the screen� That’s one you’ll use all the 
time� Make sure the image is selected before 
choosing Fit to Stamp�

The next step is to choose a filter� Click the 
painter’s palette icon in the upper right 

corner of the design area�

These three icons are used with every stamp: 
Design View, Filters, and Send to Mint�

We’ll go over the filter choices 
in more detail with other 

stamps, but for this simple stamp let’s stick with 
the standard filter� If the design you choose doesn’t 
show up with the Standard Filter, you may need to 
tweak the brightness slider until it does� (Light 
colors are susceptible to disappearing until you 
reduce the brightness�) Make sure the design is 
selected before choosing a filter�

It’s a good idea to save your projects 
before sending to the Mint� Use the Save 

icon or File > Save As, and then give it a name 
before saving to your hard drive in case you want 
to print it again or make any changes later�

Now go to the Mint leaf icon and plug in 
and turn on your Mint machine� Notice the 

image has automatically mirrored itself so it will 
print correctly�
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Mint it.
The steps are all listed right there for you to follow 
in the Send to Mint window� 

 f Step 1: Check your filters, which we just did� 

 f Step 2: Click the on-screen “Start Mint” 
button� The Mint’s light will start to flash�

 f Step 3: Insert the stamp sheet into the 
Mint� Mint Studio™ tells you the size to use, 
which is based on the size you chose when 
you start designing your stamp�

The colors on screen don’t matter, so don’t worry 
if it looks dark or ugly� You’re not printing this�

Insert the stamp sheet with the black stamp 
material facing up� Leave the thin plastic layer 
intact� The pointed end of the carrier sheet with 
the arrow goes into the back side of your Mint, as 
shown in the software�

The machine will grab it and pull it through, so you 
can let go as soon as the Mint takes hold of it�

It’s pretty fast, and it automatically feeds the sheet 
through as it prints� The finished stamp will come 
out the front, and you can pick it up as soon as the 
Mint’s blue light stops flashing�

To assemble the stamp, take the correct stamp 
base, which is the 30 x 30 mm square, in this 
case� Open the lid and remove the backing to 
expose the adhesive where you’ll place the printed 
stamp material�

Fold and tear the stamp sheet along its 
perforation, and then you can get to the stamp 
material under the thin plastic layer� The carrier 
sheet can be discarded� 

Pick up the black printed stamp and place it onto 
the exposed adhesive of the stamp base so the 
image is still facing up�
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Ink It.
We’re using magenta Mint ink for this stamp� You 
should use Mint ink for best results because it’s 
specially formulated for proper absorption and 
reinking over time�

Squeeze the ink out over the entire design� You 
don’t need to cover the entire black surface, 
but you do need to make sure it covers all of 
the design itself� Don’t get it too thin� You want 
enough ink to be absorbed�

Now wait about 5 minutes for the ink to absorb 
into the design� It won’t all soak in, but most of 
it should�

After waiting for most of the ink to absorb, you 
can stamp this onto a clean piece of paper to get 
rid of the excess ink� The solid material resists the 
ink and the printed portion soaks it in, so there’s 
always some extra ink sitting on top that you need 
to stamp away�

Stamp at least 10 times onto the paper, and you’ll 
see the design itself gets clearer as you continue� 
Keep stamping until all you see is the stamp image 
and not any ghosting of extra ink on the edges�

When you get a clear image, you can stamp onto 
one of the two labels that comes with each stamp 
sheet� Place the stamped label on the stamp lid so 
you know exactly what’s in there� You can save the 
second label as a spare�
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Stamp it.
Now you can use this stamp anywhere you 
want� A stamp like this works well on the back of 
handmade cards or on tags for homemade treats�

You can stamp up to 50 times, and sometimes 
more, with this same stamp� When it starts to look 
dry, just add the same ink, wait about 5 minutes 
for it to be absorbed, and blot the stamp on clean 
paper again� You can reink your stamp as many 
times as you want�

Use this same wooden stamp base for as many of 
the same size stamps as you want� If you already 
have this 30 x 30 mm base, you can buy refills as 
“stamp sheet sets” instead of buying the base in a 
“stamp kit” each time�

A “stamp sheet set” comes with two stamps of 
the same size that you can create and use on an 
existing base� If you need a new base with a single 
corresponding stamp, you would purchase the 
“stamp kit” instead�
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Personalize a Stamp with Text

Mint Studio™ provides a lot of ways to customize 
your stamps� This time, we’ll work with several 
different design elements, including text, to make 
our stamp more personal�

Design it.
Open a new document in Mint Studio™, choose 
Stamp Settings, and pick a stamp size� Let’s make 
this one 45 x 45 mm�

We’ll use a frame, a library design, and some text�

Start with a rounded rectangle from the 
frames� Hold your Shift key while dragging 

the rectangle to get a perfect square� We can align 
everything later�

Let’s also turn this into a dotted line� With 
the frame selected, go to the Line Style 

Window and choose these tiny dashes�
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To add text, choose the Text icon on the 
left sidebar and click down on the design 

page to create a cursor�

Type “Mrs� Jones says” and get your text tool 
again and type “GOOD JOB!”

The Text Style window has automatically 
opened, and you can also choose it from 

the icons at the top�

Select all the text and choose a font from your list� 
This font is Kolette Jot Thick (Design ID #43646)� 
To enlarge the bottom section of text, select just 
that part and set it to 48 pt or drag the corner 
handle outward to increase the size� 

Open the Apple design (Design ID #1726) from 
your Library after purchasing it from the Design 
Store� It comes in a little too large and in front of 
the other objects on the page, but you can place 
it below the text with a right-click and selecting 
“Send to Back�”

Drag a corner handle to shrink the apple down to 
about 0�85 inches�

Now it’s time to rearrange all these elements so 
they look balanced and centered� Drag the text 
toward the top and bottom borders, and then you 
can use Align tools for the rest�

You can find your alignment options by going to 
Object > Align and choosing any of these options 
for your selected shape or shapes� For a nice visual 
representation, choose the bottom option that will 
open all the align tools in a panel on the side�
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Select the dotted border and choose Center to 
Stamp� That centers the border without resizing�

Now select all the pieces together and choose 
Align Center to line them up with the outer border� 
Nudge individual parts of the design with your 
keyboard arrow keys as necessary�

Mint Studio™ has a fun curved-text 
feature, so select the top line and open the 

Curved Text window� There are a lot of curved text 
options, so just play around to see what you like�

This design uses the rounded upper curve�

To reduce the text size, hold the Alt key (or Option 
on a Mac) while dragging a corner handle inward� 
This resizes the text proportionately and makes it 
hold its position on the stamp�

Nudge things up and down with your arrow keys 
to finalize their positions�

If you want to, you can change the colors of the 
objects on your design to experiment with what 
ink color you might want to use�

We’ll make this all one color so it’s easy to give 
this as a gift� That way you can include the ink with 
the stamp for re-inking�

Select everything and change it to red� 

Notice the apple color didn’t change� That’s 
because designs you purchase from the 
Design Store currently open as raster images in 
Mint Studio™� That means it’s a raster image or 
picture instead of a vector�

Vectors can be infinitely scaled without losing 
resolution and can also be ungrouped, recolored, 
welded, and otherwise manipulated� Vectors 
include text, drawing tools, the original 50 Mint 
designs, and any Silhouette Studio® cut files you 
open in Mint Studio™�

Raster images include Design Store purchases 
like this apple and any photos or images you bring 
in like photographs or clipart� Raster images can’t 
be ungrouped in Mint Studio™, but you can still 
apply filters�
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You won’t see colors change on a raster image 
unless you’re in the Filter preview� Raster images 
keep their original colors in the Design view�

Colors on screen don’t really matter anyway 
because you’re going to physically apply the ink 
color yourself� This explanation is to help you 
understand why some parts of your design may 
behave differently than others�

Go to the Stamp Filters next� 

Now the apple has turned red with the rest of the 
design� If you ever have light colors that disappear 
when you come to the Filters preview, you just 
need to adjust the filters by doing something 
like decreasing the brightness or increasing 
the contrast�

You need to select an object before changing the 
filter settings for it, so select the apple�

Solid images can look fun with the lower filters 
applied, like Stripes� All filters can be adjusted, and 
we’ll cover that in the final lesson�

We’ll leave the apple with the Standard filter� 
Everything else on this design looks good, so we’ll 
leave it alone�

Mint it.
Now you can send your stamp to the Mint� 

Click the mint leaf to go to the Send to 
Mint window�

Follow the instructions to check the filters, click 
Start Mint in the software, and then feed the 
correct stamp sheet size (45 x 45 mm) into the 
back of the Mint�

Pull the sheet out once the machine’s light 
stops flashing�

Bend the stamp sheet at the perforation to access 
the printed stamp�
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Apply the stamp to the exposed adhesive on the 
45 x 45 mm stamp block�

Ink it.
Add red ink and wait about 5 minutes until the ink 
is mostly absorbed�

Stamp it.
Stamp the block on paper repeatedly until you see 
a clean image�

Stamp the included label and apply it to the 
stamp lid�

This personalized stamp is going to a teacher, so it 
would be nice to include the bottle of red ink with 
the stamp so she can reink it as needed� 

Now you know some of the tools, such as text and 
filters, you can use to customize your stamps� In 
the next segment we’ll talk about using multiple 
colors of ink on a stamp and how to bring in 
external images, like a brand logo�

Note: You can place a sticker label to the 
wooden base itself to be seen while stamping, 
but you would only do this on a block you don’t 
plan to use with other stamp mounts of that 
size�
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Multicolor Stamps and Branding

As you’ve seen already, the Mint machine is 
perfect for making personalized stamps� So why 
not use it for business with your brand name or 
logo? In this lesson, we’ll show you how to bring in 
an external image to add to your stamp�

Design it.
In Mint Studio™, start with a new document and 
choose a stamp size� This one will be 60 x 30 mm�

Let’s add a logo to use this with a brand 
for business�

Use the Open command and navigate to 
where you have a logo image saved� 

Mint Studio™ will open a variety of image file 
types, including JPG and PNG�

Select the image and choose Fit to Stamp 
to make it a more manageable size�

You can further resize it with the corner 
handles or Scale options and move it over 

toward the left edge in order to fit more text�
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We’ll add a library design called Thank You Script 
(Design ID #80034)� 

Resize the thank you design to about 1�5 
inches wide�

If the white background of image files cover other 
parts of the design, remember you can right-click 
and select Bring to Front or Send to Back to layer 
each piece� 

In this example, we’ll add text that says 
“for your business” with the text tool and 

adjust the font and size with the Text Style options� 
We’re using ZP Pea Green font (Design ID 
#181126)� Nudge the lines of text closer together 
as necessary with your keyboard arrow keys�

Remember, you can open all your Align options 
with Object > Align > Align Options� Center the 
text and Group it with a right-click menu choice�

Vertical alignment doesn’t work to align this 
particular logo because of the extra white space, 
so we can eyeball it for visual balance� The colors 
on screen don’t matter because we’ll add the ink 
ourselves, but we don’t want any of the designs 
that will be taking on different colors too close 
together� We’ll discuss proximity of varying colors 
in another section�

You might want to add a web address on your own 
brand stamps�

Check the Filters� To thicken up the “thank 
you” text, Ungroup (right-click > Ungroup) 

and decrease the brightness on just that piece of 
the design� Remember to select the individual 
elements to add different filters to different parts 
of the design�

Mint it. 

Send to Mint and follow the instructions 
again to print your stamp�
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Remove the stamp from its carrier sheet�

Apply it to the stamp block�

Ink it.
This time, we’ll apply two Mint ink colors� One for 
the logo and one for the text� You can do this in 
two parts and blot the colors separately, or you 
can put both colors on at the same time�

The trick is to keep the two colors from touching 
each other, because they will merge and blend if 
they touch� Carefully add green to the logo and 
black to the text, and then wait about 5 minutes 
for the ink to absorb�

Stamp it.
Stamp multiple times on paper to remove the 
excess ink, and then stamp the label�

Now your stamp is ready to be used on precut 
stickers, business cards, or notes�

Can you see how easy it is to add a logo and 
create stamps that are great for business? You 
also learned how to add multiple ink colors in a 
design� We’ll cover multiple ink colors more in the 
next section�
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Multicolor Large Stamp

In this project, let’s make a large stamp� The 
largest stamp size you can make with the 
Silhouette Mint™ is 90 x 45 mm� That’s about 
3�5 inches x 1�8 inches� We’ll talk about using 
the drawing tools, importing Library designs as 
vectors through Silhouette Studio®, and utilizing 
line properties�

We’ll also add several ink colors to this stamp�

Design it.
Start with a new document and a stamp size of 
90 x 45 mm�

We’ll make another horizontal stamp, but if 
you ever want to make a vertical stamp, it’s 
easy to change the orientation in the Stamp 
Settings panel�

We’ve talked in previous projects about opening 
purchased Library designs, which open as 
raster images� You can’t ungroup and do much 
to manipulate raster images, but there’s a way 
to get those same designs as vectors by using 
Silhouette Studio®�

Silhouette Studio® is a free 
software program (download at 
www�silhouetteamerica�com/software)� Once 
you connect your Silhouette account, all of your 
Silhouette Design Store purchases you make 
from Mint Studio™ automatically load into the 
Silhouette Studio® Library� 

Library designs in Silhouette Studio® open as 
vectors, which if you remember means they can 
be infinitely scaled without losing resolution, and 
they can be ungrouped and manipulated in many 
ways that raster images can’t be�

https://www.silhouetteamerica.com/software
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In Silhouette Studio®, Open “Happy Birthday 
Sketch” design (ID #94436), and then 
immediately save it as a Studio file (File > Save As 
> Save to Hard Drive)�

Go back into Mint Studio™, click the Open 
icon, and find the Studio file you saved to 

your hard drive� Mint Studio™ will open 
Silhouette Studio® files, and the images open as 
vectors as though they were vectors in 
Silhouette Studio®�

Choose the Fit to Stamp option, and then 
resize it a little smaller with your Alt key 

(Option on a Mac) while dragging a corner handle�

Let’s use the frame drawing tools to draw a 
frame with fancy edges�

All the frames have adjustment options; watch for 
sliders in the middle and red or white adjustment 
dots� We’ll leave this frame in its original form for 
this design�

You could add additional shapes, which are 
adjustable as well� Be sure to take some time 
to play with the various frames and shape 
drawing tools�

Adjust the frame with its side and top handles 
so it looks even on all sides� Use Object > Align 
> Center to Stamp to center the design without 
further resizing�

Now let’s adjust the happy birthday design� 
Because it’s a vector, we can Ungroup it (right-
click and select Ungroup) and adjust the spacing 
between the words by nudging it using the 
keyboard arrow keys�
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This would be a great all-purpose birthday stamp, 
ready to stamp at a moment’s notice for any gift 
tag or card� But just because we can, let’s alter the 
design and personalize it� Save your current stamp 
before moving on�

Select the design in its entirely, choose Ctrl (or 
Cmd) C to copy, and then open a new document 
of the same size and press Ctrl (or Cmd) 
V to paste�

Choose Object > Align > Center to Stamp to get 
the design back into position, if necessary� Shrink 
the text to about 2�5 inches wide with Alt (or 
Option) while dragging a corner handle� Delete the 
bottom line that says “to you�” Deleting portions of 
a design is easier to do with vectors�

Choose the Text tool and type out a name� Change 
the font to something fun like “I Love Glitter” 
(Design ID #248245)� Reposition the text off to 
the left and align their centers with each other 
(Object > Align > Align Center)�

To add one more fun element, grab your text tool 
again� Type the letter “b” and change the font to 
the “LW Birthday 2 Dingbats” font (Design ID 
#225792)� Characters from Dingbat fonts are fun 
to use as part of your Mint stamps�

Resize the design to be a little larger, if 
necessary� To thicken up fonts, click the 

lower left circle to add a thick outline, and then 
open the Line Style window and adjust the 
thickness� We’ve adjusted the line thickness on the 
name and cake to 1�0 pt in this example�

Let’s bump up the thickness of the letters 
too� Open the Line Style window, select all 

the words, and adjust it to 1�5 pt thickness�

If you compare this design brought in from 
Silhouette Studio® to the original raster image 
as opened from the Mint Studio™ library, you’ll 
see we can’t ungroup the raster image and can’t 
change its line thickness�

Another perk to using a vector is you can change 
the colors in the Design view� We can change 
“birthday” and the frame to be teal, “happy” to be 
blue, and “to you” to be green� In the end, what 
matters are the actual ink colors I apply to the 
stamp, but I like to see a visual representation on 
screen to help me choose my colors�
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Finally, we can make this stamp bright and 
cheerful with a bunch of different colors� “Happy” 
is blue, “Birthday” is green, “James” is orange, the 
cake is red, and the outline is yellow�

When it looks good, check the filters and send the 
design to the Mint�

Mint it.
Follow the steps previously listed (page 8) to 
print and then assemble your stamp�

Ink it.
Remember to be careful adding ink to this design 
because the colors will blend together if they 
touch� If you’re concerned about colors bleeding 
into each other, you should leave bigger gaps in 
your initial design� 

Wait for the ink to soak in and then stamp it on a 
piece of paper until the excess ink is stamped off 
and the design is clear�

Stamp it.
The generic happy birthday stamp will be great for 
party favors or when you’re running late to make a 
card or gift tag�

The second stamp is a fun way to show off the 
colors and make a special stamp with the birthday 
boy’s name�

Now you know some advantages to importing 
and using your library designs as vectors and 
how to access more frames and shapes in 
Mint Studio™� In the final section, we’ll discuss 
using photographs and crop tools�

Note: Over time, colors in close proximity may 
bleed into each other, even if the ink did not 
touch during the initial inking process� You can 
generally reink with the colors you originally 
intended over the top, and the stamp will show 
the fresh colors� The wider the gaps between 
the colors, the more you can prevent colors 
from bleeding into each other over time�
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Photo Stamps

In this final project, you’ll learn how to make 
a Mint stamp with a photograph, work more 
with filters, and how to use the Mint Studio™ 
crop tools�

Design it.
In Mint Studio™, choose a stamp size of 
45 x 45 mm�

Open the folder where you’ve saved a 
photo you want to use, select it, 

and open it�

If your photo comes in really large, just 
select it and choose the Fit to Stamp 

option, located on the bottom taskbar� Then you 
can resize it further from there� We’ve resized this 
stamp to be larger than the square border� We’ll 
crop the edges, but the photo will fill the full 
square stamp�
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The next step is to choose a filter, so go to 
the Filter window like we have with our 

previous stamps in earlier segments�

Any part of a design within the stamp area will 
show the filter� If the photo is off the stamp area, 
the filter won’t show�

Make sure you select the photo before changing 
any filters because each object on the page can 
have its own filter applied�

You could adjust the brightness on this Standard 
filter, but the Realistic filter is a good choice for 
people or faces�

Each filter has sliders to adjust, and we’ll set the 
Brightness on this particular photo to 40% with 
the Realistic filter� You can play around with the 
filters and sliders for each filter to customize your 
photo� Just keep in mind that not every photo will 
translate well to a stamp� You can ignore any part 
of your photo that’s outside of the stamp area� The 
Mint will not print it�

When you go to the Design view again, the 
filter looks like it has disappeared, but the filter 
will still be there in the Filter preview and in the 
Send preview�

This stamp is ready to Mint, but first let’s look at 
Crop tools with a different picture� For the final 
example, we’ve got a square of digital pattern 
paper that’s already been imported and resized� 
And just as a reminder, we’re still working with a 
45 x 45 mm stamp size�

Go to the Crop window at the top, and you 
can see there are several crop templates, 

some knife tools, and a magnet trace tool� 

You can even choose a frame or shape drawing 
tool on the left sidebar to draw out a different 
crop shape to apply as a crop template, but in this 
example, we’ll use a heart preset crop template 
from the Crop tools�
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Uncheck the Auto Apply box for the crop tools, as 
a general rule, because then you can position and 
resize the shape before applying the crop�

Choose the heart crop template and drag it across 
the pattern image� You can reposition or resize the 
heart or image until you have it where you want it�

When you’re ready to crop, make sure the heart 
is selected and choose “Apply Selected Shape as 
Crop Template�”

Now you’ve got a perfect heart cutout, which you 
can drag over and fit to your stamp�

Move to Filters, and this time let’s use 
Comic (Fill), which is another popular 

choice for photos�

Adjust Contrast and Pattern percentages� 
Remember that the filter’s effects will likely be 
different with every photo you try�

You can still add other design elements to your 
stamp, such as text or other shapes, if you want�

Now both of these stamps are ready to Mint�

Mint it.
Send each stamp to the Mint� See page 8 for 
instructions�

Apply each stamp to its base�

Ink it.
We added black to the girls’ stamp� On this heart, 
we’ll add orchid, pink, and lavender where they 
are purposely touching� They’ll blend and mix a 
little, but it’s okay in this case since the colors go 
well together�
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Stamp it.
As you know by now, wait for the ink to absorb 
and then stamp away the excess ink�

You can see how easy it is to use photos and other 
images to turn into custom stamps with your Mint 
machine� You can get clever with cropping or just 
choose a filter and go!
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Conclusion

We’ve covered a lot of ways you can create your own custom Mint stamps in Mint Studio™� It can be as 
simple as opening a design, fitting it to your stamp, and sending it to the Mint machine� But now you also 
know a lot of clever tricks in Mint Studio™, such as using shapes, frames, cropping, and text tools� We 
hope you try out some photos for your stamps too�

If you want to learn more about ALL of the features you can use in Mint Studio™ to customize your 
designs, please check out the Mint Studio™ Playlist on our YouTube channel�

You’ll also find lots of Mint inspiration on Silhouette101�com� And, as always, if you need extra help you 
can reach out to Silhouette Support at silhouetteamerica�com�

We hope you enjoy making your customized Silhouette Mint™ stamps with your newfound skills!

Designs Used:
Made with Love | Design ID: 238969 | Page 5

Apple | Design ID: 1726 | Page 12

Kolette Jot Thick font | Design ID: 43646 | Page 12

Thank You Script | Design ID: 80034 | Page 17

ZP Pea Green font | Design ID: 181126 | Page 17

Happy Birthday Sketch | Design ID: 94436 | Page 20

I Love Glitter | Design ID: 248245 | Page 21

LW Birthday 2 Dingbats font | Design ID: 225792 | Page 21

Cute Spring Flower Watercolor Pattern | Design ID: 212761 | Page 24

https://www.silhouette101.com/
https://www.silhouetteamerica.com/
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